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In approximately one hour, completing this tutorial will give 
you   a basic working knowledge of CitectHMI/SCADA version 
7.10 software. 
 
Learn how to build a small project, configure dynamic 
graphics, create alarms and trends, and then run your 
project like a real plant. 
 
This tutorial will also show you some shortcuts that, over 
time, will save you far more than the one hour you may take 
to complete the exercises inside.   
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Quickstart Tutorial 
 
Welcome, and thank you for purchasing CitectHMI or CitectSCADA.  We would like your experience with the 

product to be a pleasant one, so we have created this tutorial to help new users get familiar with some of the 

fundamental features of the product.  

 

The tutorial is designed so that you can complete it in around one hour. The tutorial is not intended as a 

substitute for attending a CitectHMI/SCADA training course. We encourage you to attend a training course to 

complete your basic training, learn how to use time saving tools or go on to learn some of the more advanced 

features of the product. 

 

This tutorial assumes that you have already successfully installed the CitectSCADA product on your computer. 

You do not require a Citect license to complete this tutorial. 

 

Repetition is an important part of learning or memorizing. One way you can speed up your familiarization is to 

take a few minutes to click through all the menus in the of something, don’t be concerned just move on to the 

next one anyway. You may not consciously remember everything product and (briefly) try and figure out what 

each item might be for, if you can’t make sense you see, but it helps to set a framework for when you revisit 

these items in the tutorial and in this way you will remember them much better. 

 

By completing this tutorial you will learn the following… 

■ Creating a New Project 

■ Setting Up Communications with a PLC 

■ Adding and Configuring tags 

■ Creating New Graphics pages 

 Use Templates 

 Button Commands 

 Disabling Buttons 

 Dynamic Symbols 

 Drawing objects 

 Manipulating objects Copy, Paste, Align, Send to Back, Color Fill, Control Commands, 

Setting values 

 Drawing Text 

 Displaying analog values 

 Drawing Pipes 

 Grouping Objects 

 Defining Alarms 

 Configure an alarm page 

 Storing Trend Data 

 Configuring a trend page 

■ Operating Runtime Displays 

■ Applying Security 

■ Using Administration Tools 

 Creating Runtime Menus 

 Tag Debug Utility 

■ Backing up and restoring a project 

Disclaimer  

Citect Pty Ltd makes no 

representations or warranties 

with respect to the contents 

or use of this manual and, to 

the extent permitted by law, 

expressly limits its liability for 

breach of any warranty that 

may be implied to the 

replacement of this manual 

with another. Citect Pty Ltd 

assumes no responsibility for 

any errors that may be in this 

document and reserves the 

right to revise this document 

at any time without incurring 

an obligation to notify any 

person of the revision. 

Copyright © October 2008, 

Citect Pty Ltd. All rights 

reserved. No part of this 

document may be 

reproduced, photocopied, or 

transmitted in any form or by 

any means (electronic or 

mechanical), for any purpose, 

without the express written 

permission of Citect Pty Ltd. 

 

Trademarks  

Citect, CitectHMI, 

CitectSCADA, CitectSCADA 

Reports. CitectHistorian, 

AMPLA and Plant2Business 

are registered trademarks of 

Citect Pty Ltd.  

Windows is a trademark of 

Microsoft Corporation. All 

other brand or product names 

may be trademarks of their 

respective holders. 
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Definition of Terms 
 
Click = Briefly press left mouse button 

 

Double Click  = Press left mouse button twice – quickly 

 

Right Click  = Briefly press right mouse button  

 

Check  = A tick or cross in an options box   

 

Type Text = Type in the word Text  

 

                 Drag  = Position mouse, click and hold left mouse button, move            

     mouse, then release mouse button 

 

Alt+Tab = Press the Alt key, hold it down, then press the Tab key 

 

                

Single Click 

 

 

Right Click 

 

  

Double Click 

 

 

Click and drag 

 

 

Type 
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CitectHMI/SCADA is made up of a several configuration tools and a runtime section.  

 

 

  Citect Explorer – Top level configuration interface  

 

 

Citect Project Editor – Mainly used for entering database type information 

 

 

Citect Draw – Used for creating graphics 

 

 

Citect Runtime – Provides the active operator interface 

 

 

You can switch between these applications by: 

 

1. Using the icons at the top left of each application, or 

2. Holding down the Alt key, then pressing Tab until the application you want is selected, then release 

the alt key (Alt+Tab), or 

3. Clicking on the icons that appear on the Windows task bar as shown below. 

 

 

To make sure that you have selected the correct icon you can let the mouse hang over the icon for about 2 

seconds and a tool tip will appear to guide you. 
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Create a New Project Folder 
Run the Citect Explorer.  

 

Click on Start 

Click All Programs 

Click Citect 

Click CitectSCADA 7.10 

Click CitectSCADA Explorer 

 

On the Tool Bar, click on the New Project icon    
 

 
 
In the New Project Dialog Box, type Tutorial in the Name field to give the new project a name, give it a 

description, then click OK. 

 
 

As you go through this 

tutorial you might like to click 

on the Help button located on 

many of the dialogs as this 

will show you some of the 

other options available to you 

that are not covered by this 

tutorial. 

 

Project Folders store all of 

the CitectSCADA files for 

your project including graphic 

pages, tag definitions, code 

etc. 

 

Clicking on a different project 

in Citect Explorer 

immediately changes the 

project you are working in. 

 

You can combine multiple 

configuration projects into a 

single runtime project using 

the “project include” feature 

described in the online help. 

 
 
Tip 

Consider using the Quickstart 

Project as this can save you 

a lot of time. 

 

Use the Example project to 

get ideas and learn how 

things are made by pulling 

them apart. 
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Configuring Clusters 
 

Clusters define where server processes (IO communications, data logging, alarming, etc), are run, and how 

different server processes interact with each other for redundancy purposes (refer to the online help for more 

details). Every CitectSCADA system must have at least one cluster defined, with related Network Addresses and 

Server roles also defined. 

 

Expand your project tree on the left-hand side of Citect Explorer and select Communications. Then double-click 

on Clusters. 

 

 
 

If the Project Editor does not appear, then use Alt+Tab until it appears. 

CitectSCADA allows you to 
quickly and easily switch 
between different projects, 
simply by selecting them in 
the Project List. 
 
TIP 
Make sure all pages are 

saved or closed in the 

Graphics Builder before 

changing projects. 

 

When you backup a project, 

everything related to that 

project, including Cicode or 

VBA script, is backed up and 

easily transported to other 

computers. The only 

exception is any 3rd party 

items which need to be 

installed separately such as 

ActiveX objects. 

 
TIP 
When networking your 

system, the project does not 

need to be copied to every 

computer. Refer projects, 

Managing your projects, 

Linking projects 
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Configuring Clusters continued… 
 

In the Clusters form that appears, define a cluster called MyCluster; give it an appropriate description in the 
Comment field, then Click Add. 
 

 
 
Close the Clusters window by clicking on the   or pressing ESC. 
 
From the pull-down menu at the top of the Citect Project Editor, click on Servers, then Network Addresses. 

 

 

IMPORTANT 
Do NOT press ENTER before 

filling in all the required fields 

in a form. Each time you 

press ENTER a new record 

will be added to the project 

creating duplicates which will 

cause compilation failures. 

 

Similarly, make sure you only 

single-click the Add button, 

rather than double-clicking, 

otherwise duplicate records 

will be added causing 

complication failures. 

 

For learners, it is better to 

use the Add button instead of 

the ENTER key. If you add 

an extra record by mistake, 

you can use the Delete 

button to mark it for deletion. 

Once marked for deletion the 

record will be ignored. 

 

If you press delete by 

mistake you can press it 

again to undelete. To view 

records marked for deletion 

go to Tools, select Options 

and check Show Deleted.  
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Configuring Clusters continued... 
 

 
In the Network Addresses form, enter the Name “MyAddress”, the Address “127.0.0.1”, and an appropriate 
Comment. 

 
 

 
 
When you are finished, click Add, then close the form. This assigns the loopback TCP/IP address to the system 
which is appropriate for Standalone systems only. We will then use that address for our server roles. 
 
We now need to assign both the Cluster and the Network Address to the various server roles that are required 
on this Citect system. This includes IO Communications, Alarming, Trending and Reporting roles. 
 
From the Servers menu select each of the server tasks in turn, and configure them as shown below: 
 

 
 
 
Use the pull-down lists where provided to minimise the chance of mistakes. 
 

 
 

TIP 

Network Addresses define 

which computers are 

available on the network to 

operate as Citect Servers. 

 

We can identify these 

computers by TCP/IP 

address, or computer name. 

 

The universal loopback 

address 127.0.0.1 is only 

appropriate for standalone 

systems with no clients. 

 

For networked or redundant 

systems, refer to the online 

help for details on how to 

configure additional Network 

Addresses and use them in 

your Server definitions. 
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Configuring Clusters continued... 

 
This identifies the Alarm Server process to run on the computer with MyAddress TCP/IP address, within the 

MyCluster server group, in the Primary mode. The Server Name “MyServer” will be used by networked clients to 

connect to this server to acquire the alarm information for display purposes. Continue for Report, Trend and IO 

Servers as shown below: 

 

 
 

 
 

 
 
 
We have now completed our Server setup and are ready to define our communications path to the PLC. 

 
 

The Tutorial project defines a 

single PC inside of a single 

cluster, and due to the 

loopback TCPIP address, is 

incapable of communicating 

to other CitectSCADA nodes 

or clients. 

 

Refer to the online help for 

details on Primary and 

Standby server functions, 

and Clustering options for 

networked systems. 
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Configure an I/O Device 
 
Use Alt+Tab to return to the Citect Explorer. Make sure the Tutorial project is selected in the project list on the 
left-hand side and that the Communications folder is open. 
 
Double click on Express I/O Device Setup. 

 

 
 
 
On the Express Communications Wizard, just press the Next button for the first three steps, 
making sure your “MyIOServer” is selected as the existing I/O Server in the second step. 
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Configuring I/O Device continued… 
 

 

 
 
 
On the fourth step, click Disk I/O Device, then click Next. This configures the system to use a hard-drive based 
device instead of a real-world device. Disk I/O devices are useful for simulation and testing situations, as well as 
for persisting recipe or other information at the SCADA level instead of in the PLC. 
 

 
 
 
On the fifth step, scroll to the top of the protocol list and select Citect Generic Protocol by clicking on it, then click 
Next. 
 

 
 
 
 
 

 
 
Disk I/O Devices are serviced 
by the Citect I/O Server, 
which means all networked 
clients are looking at the 
same data. Disk data values 
are retained on shutdown as 
they reside on the I/O 
Server’s hard drive. 
 
 
Local Tags are serviced by 
each individual Citect node, 
so each client is looking only 
at its own data. Local Tag 
values are not retained when 
the Citect node is shutdown. 
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Configuring I/O Device continued… 
 
 

 
On the final two screens you just need to press the Next & Finish buttons. 
 

   
 
Your system has now been configured to access a disk-based PLC to write and read data. Now we need to 
configure the tags in this PLC that the system will use to control equipment. In this tutorial we will be controlling a 
pump, its mode, and its speed.  
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Configuring Tags 
 
Variable Tags are a core building block for a CitectSCADA project. Tags provide the link between the operator 
and the real-world. We will create three tags to represent our pump, a Run/Stopped status tag, an Auto/Manual 
control tag and a Speed control tag. 
 
Making sure the Tutorial project is selected, click on the Tags folder. Then Double Click 
on Variable Tags in the right-hand pane. 
 

 
 
This will bring the Project Editor to the foreground and display the Variable Tags dialog. If it does not appear, use 
Alt+Tab to switch the view to the Project Editor. 
 

 
 
 
 The Project Editor is mainly for editing 

database type information.  
 

The Variable Tags Database has one record 
for each Tag you define.  
 
Each Tag has multiple fields.  (Variable Tag 
name, Data Type, Address etc) 
 
You can see the record number indicated in 
the bottom left of the dialog box 

IMPORTANT 
Do NOT press ENTER 
before filling in all the 
required fields. Each time you 
press ENTER a new record 
will be added to the project 
creating duplicates which will 
cause compilation failures. 
 
Similarly, make sure you only 
single-click the Add button, 
rather than double-clicking, 
otherwise duplicate records 
will be added causing 
complication failures. 
 
For learners, it is better to 
use the Add button instead of 
the ENTER key. If you add 
an extra record by mistake, 
you can use the Delete 
button to mark it for deletion. 
Once marked for deletion the 
record will be ignored. 
 
If you press delete by 
mistake you can press it 
again to undelete. To view 
records marked for deletion 
go to Tools, select Options 
and check Show Deleted.  
 
To permanently remove 
deleted records from the 
project, go to File then select 
Pack. 
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Configuring Tags continued… 
 
 

 

  
 
Next you will configure three tags as shown below. Remember to fill in the form before pressing Add or 
Enter. Use the Tab key or the mouse to move between fields. 
 
To make corrections after you have pressed add, you can move to the Tag or record by using the scroll bars on 
the right-hand side, then press Replace when you have made the changes. 
 
The cursors have been added as a guide to show you where you should type and where you should click. 
 

 
 
If you are having difficulty reading from the screen grabs here is the information in plain format. 

 
  Pump_1_CMD Data Type DIGITAL 
I/O Device 
Name 

IODev Address D1 

Raw Zero 
Scale 

 Raw Full 
Scale 

 

Eng Zero 
Scale 

 Eng Full 
Scale 

 

Eng Units  Format  
Comment Pump 1 Command – On/Off 

CAUTION 
Where a drop down is provided you should use it. If you mistype data into 
fields that require specific settings you may cause compile errors. 
 
 
 

You can save a lot of time 
configuring tags by entering 
similar types of Tags together 
and just changing the parts 
that are different before 
pressing Add. 
 
Use the mouse to highlight 
the parts that you want to 
change, then just overtype. 
Eg; Pump_1_CMD can easily 
be changed to 
Pump_1_Mode. Highlight 
CMD then type Mode. 
 
For address based protocols, 
if you arrange your variables 
in your PLC into blocks 
where all the Digitals are 
contiguous and all the 
Integers are contiguous then 
the performance will be 
significantly improved as the 
CitectSCADA software will be 
able to read large blocks of 
data in a single 
communication message 
instead of multiple messages.  
 
TIP 
It does not matter what order 
the addresses are entered 
into the variables records, 
what matters is the 
contiguous block of 
addresses in the PLC. 
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Configuring Tags continued… 
 
 
 
 
 
 
 
 
 
 
 
 

Variable 
Tag Name 

Pump_1_Mode Data 
Type 

DIGITAL 

I/O 
Device 
Name 

IODev Address D2 

Raw Zero 
Scale 

 Raw Full 
Scale 

 

Eng Zero 
Scale 

 Eng Full 
Scale 

 

Eng Units  Format  
Comment Pump 1 Mode – 0 =Auto, 1 = Manual 

 
 
 
 
 
 
 
 
 
 
 
 
 

Variable 
Tag Name 

Pump_1_Speed Data 
Type 

INT 

I/O 
Device 
Name 

IODev Address I1 

Raw Zero 
Scale 

0 Raw Full 
Scale 

32767 

Eng Zero 
Scale 

0 Eng Full 
Scale 

500.0 

Eng Units RPM Format ###.#EU 
Comment Pump 1 Speed (0 – 500 rpm) 

 
NOTE: For the Format field, “EU” needs to be typed up after ###.# 

 
When you are finished, use the scroll bar on the right to scroll through each tag (record) and double check that 
you have entered the correct information. On the last tag, check that the number of tags (records) = 3.  

 

CitectSCADA automatically 
saves your configuration to 
disk each time you add, 
replace or delete a record. 
 
Graphics behave differently 
where you must save your 
pages as you develop them. 
 
 
 
TIP 
Engineering Units which are 
not included with 
CitectSCADA’s default pull-
down list can be typed in 
manually. Any text can be 
entered as engineering units. 
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Close the Variable Tags window by clicking on the  or pressing ESC. 

Creating Graphic Pages 
 

 
Before you start let’s take a look at what you will create. 
 

 
 
This page contains a number of buttons that allow the operator to control the pump’s mode and operation, as 
well as a slider to control its speed.  
 
The pump itself will animate red or green depending on whether it is running or not, and the lights, bar graph and 
number will indicate its mode, operation and speed. 

 



 

 
Page 18 of 80 

Quickstart Tutorial V7.10
 

18  

Creating Graphic Pages, Creating a new page 
 

Switch to the Graphics Builder – click on the Graphics Builder icon .  
 

Click on the New Page  icon. A popup form will appear allowing you to select what type of new 
graphics object you would like to create. 
 

 
 
Click on the Page button. An additional popup form will appear allowing you to select a base template from 
which to create your new page. 
 

 
 
 
Make sure XP_Style is selected in the Style box, then Double Click the Normal template as 
shown. 

 
 
 
 

The fastest way to drive any 
application is with the 
keyboard. Most programs 
have shortcut keys – you 
may be surprised how quickly 
you can learn them.  
 
 
 
Templates provide a vast 
range of pre-built 
functionality, making the task 
of building a new project with 
CitectSCADA extremely fast. 
 
All pages must be based on a 
template, even if it is a blank 
template. 
 
If you want to customize the 
look and feel of your pages, 
you can create your own 
templates from scratch, or 
copy the existing ones and 
modify them. 
 
 
 
 
NOTE 
Never modify templates, 
symbols or other items in the 
Example, Include or 
CSV_Include projects! These 
projects will be automatically 
re-loaded when you upgrade 
to the next version and your 
changes will be lost. Always 
copy items to your local 
project before modifying 
them. 

Instead of double 
clicking on Normal 
we could single click 
on Normal and then 
click OK – but that 
takes more time. 
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Creating Graphic Pages, Saving your page 
 

 
We are using the built-in templates to get a jump-start on your page. There are navigation buttons already 
configured for you and using templates helps to ensure a consistent look and feel throughout your project. This 
is very important if you want to make it easy-to-use for your operators. 
 

 
 
It is good practice to save your graphics pages regularly, so let’s begin the habit right now.  
 
Click on the Save icon on the menu bar . 

 
Type MyPage in the Page edit box, then press OK. 
 

 
 

You can move the Toolbox 
by placing the cursor on the 
title bar, hold down the left 
mouse key while moving the 
mouse. 
 

 
 
If your toolbox does not 
appear, it can be toggled by 
pressing the F3 button, or 
selecting it from the View 
menu. 

Templates are 
displayed pretty much 
as they appear at 
runtime.  
 
###.## indicates 
dynamic values that will 
change at runtime. 
 
 +1, +2 etc are 
Animation Numbers that 
are used as references 
for graphics objects that 
will be displayed at 
these locations in 
runtime. Animation 
Numbers are not 
displayed at runtime. 
 
ƒ(x) is a script that is 
executed with the page. 
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Creating Graphics pages, setting up the Grid 
 
Firstly we will setup a grid which will allow our cursor to snap to uniformly positioned locations on the screen, 
making it easier to size and position objects in relation to each other. 
 
On the toolbar, click View, then Grid Setup. 
 

 
 
In the Grid Setup form, change the size of the grid from 8 x 8 pixels, to 5 x 5 pixels as shown below. Select 
Snap to Grid, and then click OK to close the form. 

 

 
 
 
Now we are ready to create and position our graphics objects. 
 

 
 
 
 
 
 
 
 

The Grid is not a necessary 
item for configuring graphics 
pages, however it vastly 
increases the ability to create 
uniform sized and positioned 
objects, which in turn makes 
your pages easier to 
visualize. 
 
If the Grid prevents you from 
positioning an object exactly 
where you want it, it can be 
toggled on and off using the 
F8 key. 
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Creating Graphics pages, Configuring buttons 
 
Next we will configure some buttons to control the mode of the pump. 
 
On the Toolbox click on the button icon. 
 

 
 
To draw the button, click and hold the left mouse button while moving the mouse then release the left 
mouse button (ie. click and drag the mouse). 
 

 
 
 
 
   The position and size of the currently selected 
object 

 are shown at the bottom right of the graphics builder  
 status bar. 

The Toolbox options are, 
from left-to-right and top-to-
bottom: 
 
Free-form line 

 Straight line 
 Square/Rectangle 
 Circle/Oval 
 Polygon 
 Pipe 
 Text 
 Number 
 Button 
 Animated symbol 
 Trend 
 Function 
 Static symbol 
 Genie 
 ActiveX 
 Process Analyst 
 Database 

Exchange 
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Creating Graphics Pages, Configuring Buttons continued… 
 
 
Once you release the mouse button, the Button Properties dialog popup will appear. Double Click on the 
word button in the Text edit box. This is a quick way to select a complete word. Next type Manual.  
 

 
 
Click on the Input tab at the top of the form to configure the action the button will perform. 
Click on the Insert button.           
Click on Insert Tag option.  
 

 
 
 
In the Insert Tag Dialog Double Click on Pump_1_Mode. 
 

 

If you don’t see the expected 
property sheet as you go 
through these exercises, then 
you may need to locate the 
correct sheet by looking at 
the screens on the page then 
click on the horizontal & 
vertical tabs to find the right 
sheet. 
 
Horizontal Tabs 
 
 
 
 

 
 
 
Vertical Tabs 
 
 
 
TIP 
Tabs with ticks on them 
indicate that configuration 
exists on that tab 
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Creating Graphics Pages, Configuring Buttons continued… 
 

 
Pump_1_Mode will be inserted into the Up Command edit box. Click your mouse to the right of the Tag 
Pump_1_Mode and type “= 1”.   
 

 
 
When the project is running, pressing on the Manual Button will set the tag Pump_1_Mode to a value of “1” to 
represent “Manual” mode. Repeated pressing of the button will continue to set the same value of “1” into the tag. 
Therefore we need a second button to set the tag to a value of “0” or “Auto” mode. 
 
We will achieve this by copying the first button and modifying the copy. We do this because it is often quicker to 
make copies of objects than to draw them from scratch. This also guarantees consistency of object sizes. 
 
Here is a quick way to make a copy and position an object. 
 
 Place the cursor over the Manual Button.  
 Hold down the Ctrl key. 
 Hold down the left mouse button.  
 Move the mouse to position the copy. 
 Release the left mouse button. 
 
You don’t need to be precise with position at this time – we will fix that later using an alignment tool. 
 

 
 

If you move the mouse immediately after holding down left mouse 
button, then you will only see the outline of the object as it is moved. 
 
If you wait half a second before moving the mouse, you will see the 
object itself being moved, making it easier to position it in its new 
location.  
 
The + sign will appear on the hand after pressing the Ctrl Key 
indicating a copy operation rather than a move operation. 

There are many ways to copy 
objects.  
 
Ctrl + D will duplicate the 
currently selected object.  
 
Ctrl + C will copy an object to 
clipboard.  
 
Ctrl + V will paste an object 
from clipboard. 
 
These last two work in almost 
all windows programs so are 
well worth remembering. 
 
You can also select Copy, 
Paste or Duplicate from the 
Edit menu or by using the 
icons on the menu bar. 
 
Copying objects also ensures 
that their dimensions are 
identical to each other, 
creating a more visually 
appealing user interface.  
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Creating Graphics Pages, Configuring Buttons continued… 
 

 
Double Click on the new button.  
In the Up Command edit box, replace the = 1 with a = 0. This will turn the digital tag Pump_1_Mode 
false to represent Auto mode. 
 

 
 
 
Click on the Appearance Tab to change the text label on the button. 

 

 
 
Double Click on the word Manual in the Text edit box, replace the text with Auto. 
Click OK when finished. 
 
We now have two buttons that will set the control mode of the pump to Auto or Manual. Next we need a control 
to turn the pump on and off. Instead of using two buttons, one for on and another for off, this time we’ll use just 
one button. 
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Creating Graphics Pages, Configuring Buttons continued… 
 

 
Make a copy of the Auto Button (hold the Ctrl key, then click and drag the Auto Button to create a copy in 
a new location). 
 

 
 
Double-Click the new button to access its animation properties, then change the button Text to read “On/Off”. 
Click on the Input tab when finished. 
 

 
 
 
In the Up Command edit box replace the current text with Toggle(Pump_1_CMD).  
 

 
 
 
 
 
 
 

You can also use the 
reserved word TRUE instead 
of a 1, and FALSE instead of 
a 0.  
 
TRUE and FALSE are not 
case sensitive, but upper-
case is a common convention 
used to indicate a reserved 
word. 
 
 
 

You can also use 
the Insert button 
to lookup the 
Toggle function 
and paste it into 
the Up 
Command. 
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Creating Graphics Pages, Configuring Buttons continued… 
 

 
We will now inhibit the Manual On/Off button from working while the pump is in Auto mode and we’ll add a tool 
tip on the way to explain this to operators.  
 
Click on the Access Tab at the top of the button form. In the Tool tip edit box type “Must be in 
Manual to turn on and off” then click the Disable tab (on the vertical tabs). 
 

 
 
 

Click on the Insert icon  . 
Click Insert Tag. 
Double Click on Pump_1_Mode and Add the text = 0 after the tag. 
Leave the disabled style as Embossed. 
 

 
 
Click OK when you’re finished. 
 
When Pump_1_Mode is “0” or FALSE (i.e. in Auto) this button will be disabled. The button’s appearance will be 
altered using the Embossed style to indicate that it is disabled and it will not highlight when the cursor moves 
over it. The tool tip will still work normally. 
 
 
 

 

Under the access tab you 
may notice there is a section 
called security. This is a very 
powerful feature in 
CitectSCADA that allows you 
to precisely define who can 
access what. Configuring 
security is covered in the 
CitectSCADA Configuration 
training course. 
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Creating Graphics Pages, Configuring Symbol Sets 
 
Our control buttons for our pump are now complete. We will now add symbol indicators to show what state the 
pump is in. These indicator lights will show whether the pump is on or off, and whether it is in auto or manual 
mode. 
 
On the Toolbox click on the Symbol Set Tool. 
 

 
 
Position the cursor next to the Manual button, then click to place the symbol on the page. In the ON symbol 
when edit box type Pump_1_Mode = 1. 
 

 
 
Click on the OFF symbol Set… button to select a different symbol to display for this state. A new popup form will 
be displayed, with a list of symbol libraries to the right, and thumbnails of the symbols within the selected library 
on the left. 
 
Scroll down the libraries until you find the “Lights Round” library, then Click on it to select it. The thumbnails on 
the left will change. 



 

 
Page 28 of 80 

Quickstart Tutorial V7.10
 

28  

Creating Graphics Pages, Configuring Symbol Sets continued… 
 

 
Select the Grey light by Double-Clicking on it. This will replace the original black light with a new grey light for 
the off state of the animation. 
 

 
 
 
Repeat this exercise for the ON symbol state, this time selecting the cyan light from the lights round library. Click 
OK when your configuration of the manual symbol is complete. 
 

 
 

Copy the Symbol Set and place the new one next to the Auto button. Again,  
don’t worry about positioning the symbol perfectly as we will align the various  
objects shortly. 

 
 
 
 
Double-Click the copied symbol to access its animation properties. In the ON symbol when edit box replace the 
expression with Pump_1_Mode = 0 then click OK. 
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Creating Graphics Pages, Configuring Symbol Sets continued… 
 
 

 

 
 
Make a third copy of the symbol set and position it next to the On/Off button. In the On symbol when edit box 
replace the text with Pump_1_CMD. Click the OFF symbol Set… button and select the Red light from the 
lights round library, then select the Green light for the ON symbol. 
 

 
 
At Runtime, when Pump_1_CMD is on (i.e. equals “1”) the Green Light will be displayed, and when it is off 
(i.e. equals “0”) the Red Light will be displayed. 

TIP 
DIGITAL tag types do not 
require “=1” in their symbol 
detection logic because 
CitectSCADA knows that 
they only have two states 
corresponding to the two 
symbol states available. 
 
This is a little different to 
when we were writing 
commands to the tag and we 
had to explicitly tell 
CitectSCADA which state to 
set the DIGITAL tag to. 
 
 
 
 
 
 
 
 
 
 



 

 
Page 30 of 80 

Quickstart Tutorial V7.10
 

30  

Creating Graphics Pages, Aligning Objects 
 

It is worthwhile making your pages look aesthetically pleasing as it will encourage operators to use the system 
and also makes it faster to find information on the screen. Making sure everything is drawn precisely, aligned 
correctly and evenly spaced also helps to make your pages look professional. 
 
You can align objects manually by dragging them around the screen until you have positioned them 
satisfactorily, and for which the Grid is an excellent assistant, however sometimes we want to align a group of 
objects quickly relative to each other. For this we use the Align tool. 
 
Select all three buttons by clicking on each of them, while holding the CTRL key down for the last two. All three 
buttons should have a selection indication at their button left, and be bounded by a large transparent rectangle 
identified by the four corners, and four center points as shown below. 
 

 
 
 
From the Graphics Builder toolbar, select Arrange, and then Align. An alignment popup form will appear, 
asking you how you would like to arrange the selected objects. Select Left for the horizontal alignment and 
Even for the vertical alignment, then Click OK.  
 

   
 
 
Repeat this exercise for the lights to the right of the buttons. Try selecting a button and a light and aligning them 
vertically via the Centre selection before aligning all three lights Evenly. Keep going until you are satisfied with 
the arrangement of the objects on your screen. 

 

 
TIP 
Another way to select 
multiple objects is to drag the 
cursor around them while 
holding the left mouse button 
down to “lasso” the objects. 
You will need to be careful 
not to select additional 
objects if you use this 
method. 
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Creating Graphics Pages, Aligning Objects continued… 
 

 
You may notice that the lights are not perfectly in line with the center line of the buttons. This is because the hot 
spot or anchor point for this symbol is in the top left of the symbol rather than in the middle. To correct for this we 
will use the zoom and the nudge tools. 
 
To make sure your objects are aligned or positioned perfectly you can use the Zoom tool.  From the Menu 
select View, Show Zoom.  
 

 
 

 
 

 
 

 

 
 
 
 
 
 

The zoom tool will display an enlarged view of the region around your cursor. You 
can alter the “magnification” by clicking in the top left corner of the zoom window 

You can change the magnification of the zoom by clicking on the 
pop-up’s window icon, and selecting to Zoom In or Zoom Out as 
required.  

You can move the zoom window by placing the cursor on the title bar (the big 
blue bar at the top) then hold down the left mouse button and move the 
mouse. 

 
 
TIP 
The Zoom tool can be quickly 
toggled on and off using the 
F10 key. 

You can change the size of the zoom window by placing the 
cursor over one corner until the resize cursor is shown, then hold 
down the left mouse button and move the mouse.  
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Creating Graphics Pages, Aligning Objects continued… 
 

 
Since the lights are in the correct position relative to each other, we will select all the lights so that we can move 
them together as a group. Place cursor above and to left of top button; hold down left mouse button and 
move mouse, then release mouse button to lasso all three buttons. 
 
If you have the Grid tool turned on, press F8 to disable the Snap to Grid function, otherwise the buttons 
will only move to the nearest grid position. 
 

You can now precisely position the lights by placing the cursor over the 
selected objects (make sure the hand cursor appears) then press Enter (or  
hold down left mouse button), next use the arrow keys on the keyboard to  
move the buttons one pixel at a time in the direction that you want. Use the  
zoom box to see exactly where the objects are positioned to the nearest pixel.   
Press enter again to set the position (or release left mouse button if you used  
that method). 

 
 

 
Save your page. 
 
 
 
 
 

Creating Graphics Pages, Formatting with Rectangles 
 

 
Next we will create a grey background to highlight our control panel. 
 
Press F8 to turn the Snap to Grid selection back on. On the Toolbox click on the Rectangle Tool. 
 
Click and drag to place a rectangle around your buttons and lights. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once the rectangle is positioned, you can easily resize it by clicking and dragging the bounding boxes in each 
corner, and the center of each side.  

TIP 
Windows XP style buttons 
have a grey border around 
the button. If you do not want 
a grey background for your 
buttons it is suggested that 
you uncheck the XP Style 
option under the 
Appearances tab of your 
buttons. 
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Creating Graphics Pages, Formatting with Rectangles continued… 
 

 
When the Rectangle Properties dialog popup appears, change the Style to Solid, the Corner Radius to 
4, the Line Color to Grey, and the Fill Color to grey as shown below.  
 

 
  
 
When you are finished, click on the 3D Effects vertical tab on the right-hand side of the form. 
 

 
 
Select Lowered from the various 3D Effects available, and retain the default depth and color options, then 
click OK. 

 

TIP 
Once a shape has been 
created you can click and 
drag the node points (1 per 
corner and 1 per side), to 
modify its size and shape. 
 
 
TIP 
Holding the Ctrl key down 
while sizing a rectangle or 
oval forces the object to have 
the same vertical and 
horizontal dimensions. This 
allows you to easily create 
squares and circles 
respectively, rather than 
rectangles and ovals. 
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Creating Graphics Pages, Formatting with Rectangles continued… 
 

 
The rectangle should now cover all of your buttons and lights, obscuring them from view. We need to send the 
rectangle to the back layer to allow the buttons and lights to appear in front of it. 
 

Select the rectangle by clicking on it, then click the Send-to-Back button  or alternatively select 
Arrange, then Send to Back from the menu bar.  
 

 
 
 
Your page should now look similar to the above. Save your page. 
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Testing Graphics Pages, Computer Setup Wizard 
 
 

It’s time to test your configuration and see how your page looks and feels to an operator. Firstly however, we 
need compile the project to make sure we have not made any configuration errors, and then we will run the 
CitectSCADA Computer Setup Wizard to configure how you want this computer to behave within your overall 
CitectSCADA network.  
 
Switch to the Citect Project Editor using Alt+Tab. From the File menu, select Compile. 
 

Alternatively you can use the compile button  on the menu bar. 
 
 
 
 
 
 

 
You should see a compilation progress bar, followed by a Compilation Success popup. 
 

   
 
 
If your compilation fails, you can double-click on an error from the list provided to take you directly to the location 
of the incorrect configuration, or you can review your work using this document to ensure that you have 
performed all steps correctly. 
 

The Computer Setup Wizard 
is typically run only once per 
project for each computer on 
which CitectSCADA will run. 
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Testing Graphics Pages, Computer Setup Wizard continued… 
 
We will now setup our Computer’s role within the CitectSCADA network. Switch to Citect Explorer using 
Alt+Tab. 
 
In the Project List tree make sure the Tutorial project is selected. 
In the menu bar, click the Computer Setup button. 
 

 
 

 
 
 
 
 
 
Check Express Setup then click Next.  
 
 
 
 
 
 
 
 
 
 
 
 
Click the Project Name Drop Down and select 
Tutorial, then click Next. 
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Testing Graphics Pages, Computer Setup Wizard continued… 
 
 

 
Check Server and Display Client, then click Next.  
Make sure you left the Multi-Process box unchecked. 
 
 
 
 
 
 
 
 
 
 

 
 
Change the networking selection from the default of 
Discovery to No Networking, and then click Next. 
This will isolate this CitectSCADA on the network to 
allow it to run as a Stand-alone system. 
 
 
 
 
 
 
 
 
 
 
Click Finish. 
 
 
 
 
 
 
 
 
 
 

 
 

We are now ready to run our project and test our controls. 
 

 
 
Multi-Processing is used to 
distribute server tasks across 
multiple CPUs and cannot be 
used without a license key. 
 
 
 
Networking enables 
communications from this 
CitectSCADA node to other 
CitectSCADA nodes on the 
network. It cannot be used 
without a license key. 
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Testing Graphics Pages, Runtime 
 
 

 

Press the Run  button. The Runtime Manager dialog will appear, showing the startup process and status. 
 

 
 
 
If you have not inserted a protection key you will see the following message: 
 

 
 
 
Click OK to run the project in demonstration mode. 
 
 
The default startup page contains a number of menu items which can be configured in runtime. To configure the 
page navigation portion of this menu, click on Pages. 
 
 

Click Update Page List… on the Pages menu will force 
CitectSCADA to update its runtime menu to include any unlisted 
(eg. new) pages. Click it now. 
 
 
 
 
 

 
 
Returning to the Pages menu you will now see your page 
included in the navigation menu. Click on MyPage now. 
 
 
 
 
 
 

 
 
Your page will now display. 

 
 
 
 
 

Testing Graphics Pages, Runtime continued… 
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Click on the Manual button then the Auto button and check to see that the appropriate light turns cyan. Also 
check that the On/Off button becomes unavailable for selection whilst in Auto mode. 
 
Move the mouse over the On/Off button and wait a couple of seconds to see that the tool tip appears. 
 
See what happens if you click on the On/Off button. 
 
Click on Manual, and then try clicking on the On/Off button again. 
 
If you’ve made it to this point, give yourself a gold star and take a moment to stretch your muscles. 
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Creating Graphics Pages, Analog Indicators & Controls 
 

 
To switch from runtime back to Graphics Builder, press Alt+Space together, then click on Graphics Builder. 
 

 
 
 
Select the grey rectangle you have already created and copy it by dragging it and holding the Ctrl key down 
on your keyboard (alternatively use standard windows copy and paste controls). Position it to the left of the 
existing rectangle and drag the resize nodes to change it to a tall, narrow rectangle as shown below. 
 
Use the Zoom and nudge, Align, or Grid tool to precisely position the Rectangle in line with the existing 
rectangle.  
 

 
 
 
Double-click the rectangle to access the rectangle properties form. 
 
Select the Appearances tab on the horizontal tabs, and the General tab on the 
vertical tabs. 
 
Change the Filled Color to bright green.  
Check the Gradient Fill option and select bright red as the Gradient Color. 
From the pull-down options, change the Gradient Direction to vertical. 
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Creating Graphics Pages, Analog Indicators & Controls continued… 
 

 

 
 
 
Once finished configuring the rectangle’s appearance, click on the Fill tab and select Level from the 
vertical tabs on the right-hand side of the form. 
 
Use the Insert button to insert the tag Pump_1_Speed. Change the Background Color to black 
then click OK. 

 

 
 

 
This rectangle will fill and change color as the pump speed increases. The 
range for the analogue value (0 to 500 RPM), is automatically derived from its 
tag definition that we built earlier. 
 
Next we will create a slider to allow operator control of the pump speed when 
it is in manual mode. 
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Creating Graphics Pages, Analog Indicators & Controls continued… 
 
You will need to know the how far (in pixels) the slider needs to move. To find this out select the gradient 
rectangle (bounding boxes will appear), and look at information provided in the status bar at the bottom right 
corner of the Graphics Builder.  
 
This status bar will show you the width and height of the selected object. Write down the height of the rectangle. 
 
 

 
 
NOTE: If the status bar is not visible, go to the View menu on the menu bar and click on Show Status Bar. 
  

On the Toolbox click on the Paste Symbol tool. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When the Symbol selection popup appears, use the scroll bars to locate the xp_sliders library and then Click on 
it to select that library.  
 

 
 
Double Click on right_normal to place it on the page. 

 
 
 
 
 
 
 
 
 
 
 



 

 
Page 43 of 80 

Quickstart Tutorial V7.10
 

43  

Creating Graphics Pages, Analog Indicators & Controls continued… 
 
 

 
Position the pointer at the left bottom side of the gradient rectangle using Zoom and Nudge or the Align tool. 
 
Double Click on the Pointer Symbol to open the Symbol Properties form. 
 
Click on the Slider Tab, then click on the Vertical Tab on the right-hand side. 
 
Use the Insert button to insert the Pump_1_Speed tag. 
 
Note that if the Continuous update of tag option is checked, then the tag will be written to while it is being 
dragged. 
 
In the At Maximum edit box type the height in pixels that you wrote down earlier. 
 
Click OK. 
 

 
 
Now is a good time for a regular page save. Click the save icon. 
 
You can compile, and run the project again to test these changes before continuing to the next chapter. If 
CitectSCADA is still running from your previous test, you will need to compile and change pages before updates 
are picked up by the running system. 
 
 
Advanced exercise: If you’re feeling adventurous, you can add a disable function to the slider (just like for the 
on/off button), under the Access tab. 
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Creating Graphics Pages, Configuring Text 
 

We will now place some static text above the buttons to label the controls. 
 

Click on the letter A on the Toolbox. 
 

Type Pump 1.  
 

Note: If you do not see the letters that you type it is most  
likely because the currently selected color is the same as the  
background color of the page. 

 
Place the cursor above the buttons and click to position the text that you have typed. An 
appearance form will be displayed to allow further customization of the text. 

 
Select Bold, font size 22 (point) and change the Foreground color to orange. 
Click OK. 
 
 
 
 
 

 

 
 
 
 
 
Creating Graphics Pages, Creating Colors 
 
CitectSCADA supports True Colors. This allows far greater flexibility when importing images, as well as 
managing colors quickly and easily. 
 
The default palette contains 128 commonly used colors however this does not restrict the number of colors 
you can actually use in your project. 
 
Double-click on the Pump 1 text on your graphics page to open the Text Properties form again. Click on the 
Foreground color. 

Flashing colors must 
be specifically 
assigned to the default 
palette. This means 
that the total number 
of flashing colors 
available to you is 
restricted to 80, which 
is more then enough 
for most projects. 
 
To create a flashing 
color, firstly click on 
the palette location 
you wish to assign it 
to, then click Add.  
 
Select Flashing from 
the check-box options. 
 
Select the first color 
(On State color).   
 
Click on Off State. 
Now select the second 
color. 
 
The palette will display 
the color as two 
triangular colors in the 
one square, just like 
those on the bottom 
row of the palette (see 
picture on next page). 
 
Colors will not flash in 
development mode – 
only in runtime. 
 
 
NOTE: If you have  
upgraded from a 
previous version of 
CitectSCADA and 
used Flashing Color 
labels, you will need to 
reassign those labels 
to new palette flashing 
colors as the old 
method of flashing 
colors is no longer 
supported. 
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Creating Graphics Pages, Creating Colors continued… 
 

 
Click on Edit. Another color form will display, allowing you to customize the color either using the mouse, or by 
entering the RBG indices for specific values. 

 

 
 
You can use a variety of options in this color editing dialog to adjust the color to any of the 32 million true colors 
available (provided your computer supports 32bit colors). In our case, we will simply Slide the Shading Cursor on 
the right-hand side up to a very pale shade, then click OK to finish and transfer the new color to your graphics 
object. 
 
Once you are satisfied with the color of your text we will add a 3D Effect of Black Shadowing using the 3D 
Effects tab on the right side of the Text Properties dialog popup. 
 

   
 
 
 
 
 
 
 

 
Save your page. 

Flashing colors 
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Creating Graphics Pages, Configuring Numbers 
 

 
On the Toolbox, click on the number tool. 

 
Click to place the number below the gradient rectangle. 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Use the Insert Tag button to enter the tag Pump_1_Speed. Leave the data format field to the default, and the 
format you specified in the tag definition will be used. 
 

 
 
 
Click on the General tab on the right-hand side and set the font to Black, 12 point, then Click OK. 

 
 
 

 
 
 
 
 
 

 
 

Creating Graphics Pages, 3D rectangles 
 

The Number tool is actually the Text tool. 
When you access it via the number tool icon 
you are presented with the Display Value sheet 
instead of the General Appearance sheet. 



 

 
Page 47 of 80 

Quickstart Tutorial V7.10
 

47  

Next we’ll add some cosmetics to make the display more appealing. 
 
Draw a large rectangle that covers all the things you have drawn so far (or copy the one you already have on the 
page).  
 
Set the Line color to Light Grey (see next page). 

 
Check  the Filled check-box and set the Filled color to Light Grey also. 
 
Set the Corner Radius to 8, and activate the Gradient Fill with a medium grey hue.  
 

 
 
 
Click on 3D Effects tab and select Lowered.  
 

Since it will be difficult to see your work with the large rectangle in front of 
it, we need to send it to the back.  
 
 
Make sure the new rectangle is selected, then click on the Send to Back 

button  on the Tool Bar, or select Send to Back from the Arrange 
menu. 
 
 
 
Click OK when finished. 
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Creating Graphics Pages, Pumps & Piping 
 
Next we will add a picture of the pump and some piping. 
 

Click on the Symbol Set tool. 
 

Click below the new rectangle to place the symbol set on the page. 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the Set button next to the OFF Symbol edit box to change the Off symbol from a black light to a red 
pump. In the Library list, use the scroll bars to scroll down and then click on pump_base_xlarge. In the Symbol 
window, Double Click on the left_red symbol. 
 

 
 
 
Click on the Set button next to the On Symbol edit box to change the On symbol from a red light to a green 
pump. Using the same technique as above, locate the left_green pump then Double Click on it.  
 
Use the Insert button to insert the tag Pump_1_CMD. Click OK. 
 

 
 
 
 
 
 
 
 
 
 



 

 
Page 49 of 80 

Quickstart Tutorial V7.10
 

49  

Creating Graphics Pages, Pumps & Piping continued… 
 

 

 
 
Configuration of the pump’s animation is now complete. We now need to add source and destination receptacles 
along with accompanying pipework and the page will be complete. 
 

Click on the Static Symbol Tool in the ToolBox. 
 
 

Using the scroll bars, locate the tanks cylindrical symbol library, and then Double Click  
tank_wide_large. Click and drag the tank to position it on the left-hand side of the page. 

 
 

                 
 
 
Repeat for a second tank, this time using the tanks_cyl_conb_30 library, with the tank_large symbol, positioned 
on the right side of the page, above the pump. 
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Creating Graphics Pages, Pumps & Piping continued… 
 

Click on the Pipe Tool in the ToolBox. 
 

The Pipe tool generates 3D rendered polylines with node points that identify bends or 
junctions. Pipes can be color filled the same as any other drawing object in CitectSCADA, and 
will render the flooded color in 3D. 

 
We will now draw two separate pipes, one from the source tank on the left side of the page, 
and one to the destination tank on the right side of the page.  

 
 
 
 
 
 
 
 
 
To draw the right-hand pipe: 
1. With the pipe tool selected, Hold down the Ctrl Key (Forces only horizontal and vertical lines to be drawn) 
2. Place cursor on top of the right-hand tank in the approximate center, click and hold down the left mouse 
        button and move mouse downwards. Release mouse key when you have moved far enough to draw the 
first      
        leg of the pipe. 
3. Move mouse to the left (release the Ctrl Key to allow diagonal pipes if you wish), and click again to create 

the 
        second leg in the pipe.  
4. Continue until you are satisfied with your pipe’s route and Double Click to end the pipe at the pump. 
 
 
Note that you can return and adjust the individual junctions of the pipe to fine-tune its position and shape later. 
 
 
Release the Ctrl Key when you are finished the pipe and the pipe properties form is displayed. Select a pipe 
highlight color of light grey and a width of 12, and then click OK to close the pipe properties form. 
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Creating Graphics Pages, Pumps & Piping continued… 
 
 

 
To adjust the pipe, select it by clicking on it. The ends and 
bends of the pipe will have small nodes shown, which can be 
clicked on and dragged to reposition them. 
 
Bounding boxes allow the dimensions of the pipe to be 
adjusted, and will scale the pipe accordingly, and will not 
adjust the width of the pipe. 
 
Carefully manipulate your pipe to align with the outlet of the 
tank, and feed into the pump approximately halfway through 
its radius. 
 
Repeat this process to create another pipe on the left-hand 
side of the pump feeding into the second tank. Don’t worry if 
you add a small section to one end of the pipe when you 
double-click as the pump or tank symbol will conceal it once 
we push them to the back layer. 
 

Once you are satisfied with the position and shape of both pipes, select both pipes by holding down the Ctrl Key 
and clicking on each pipe. Release the Ctrl Key. 
 

Click the Group button  on the tool bar (or select Group from the Arrange menu).  
 

Click the Send to Back button  on the tool bar (or select Sent to Back from the Arrange menu). 
 
Double Click on either of the pipes that you have drawn. You will notice that the configuration dialog displayed is 
for Group Properties rather than Pipe Properties. All configurations you now perform will apply to all objects 
contained within the group, in this case, the two pipes. 
 
 

Click on the Fill Tab. Insert 
Pump_1_CMD tag into the ON color 
edit box. 
 
Set the Off Color to light grey and the 
On Color to Green. Click OK. 
 
Your configuration of the pipe work is 
now complete. 
 
Save the page. 

 
 
When items are grouped, 
double-clicking on them will 
access the group 
configuration, however 
objects inside of the group 
can have their own animation 
properties independently of 
the group’s properties.  
 
To access the individual 
objects within the group, hold 
the CTRL key down while 
double-clicking the object. 
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Creating Graphics Pages, Pumps & Piping continued… 
 
 
 

 

 
 
Your graphical configuration for this tutorial is now complete. You can test this by running the project again, and 
then continue to the following sections which address color management, alarm handling, and trending, as well 
as customizing the navigation menu and Administration Tools. 
 
If you’d like to practice the skills you have just learned, try adding a bar graph to the tank to indicate level (you 
can add a slider to simulate a level transmitter). 
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Creating Graphics Pages, Managing True Colors 
 
CitectSCADA comes with two excellent tools for adjusting colors, making it very easy to manipulate images from 
shades of red to green to yellow and so on, even for very complex true-color images. 
 
We will manipulate a simple image in this example, but the same principles apply to any true color image that 
you create or import to the application. 
 
Click on the left-hand Tank symbol to select it. 
 

From the Edit menu, select Cut Link. This will sever the symbol’s link with 
the library and allow us to manipulate it as a stand-alone object. If we did 
not sever this link, then we would have to modify the object in the library 
rather than on the page, which would distribute the change to all instances 
of the object throughout the project. 
 
Note that you should never modify the libraries that are supplied with the 
product. If you require a variation of these objects, you should copy them 
into your own library, and create the variations there. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
From the Tools menu, select Swap Colors. 
 

 
 
 
 

 
 

Creating Graphics Pages, Managing True Colors continued… 
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Making sure that the Swap Range option is selected, select any shade of grey for the From Color, and any 
shade of purple for the To Color, then click OK. The tank should now be a 3D rendered purple variation of the 
original grey object. 
 

 
 
For more flexible color management, you can use the Adjust Colors tool, also available from the Tools menu. 
This tool allows you to select from a flexible range of colors for migrating from one hue to another, as well as 
adjusting saturation and darkness at the same time. This can be very useful when one color range does not 
translate well to another. 
 
Use the Adjust Colors tool to change your purple tank to green, and darken the hue by 20%. 
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Accessing Alarm and Trend Display Pages 
 
 

CitectSCADA comes with a number of pre-built pages. If you do not specifically define these pages in your 
project to create your own look and feel, then CitectSCADA will use its defaults instead. This includes: 
 
■ Alarm 
■ Summary Alarms 
■ Disabled Alarms 
■ Hardware Alarms 
■ Trends 
■ Double Trends 
■ Popup Trends 
■ Instant Trends 
■ Administration Tools 

 
As well as the page template which we are already using which provides built-in navigation and alarm shortlist 
features. 
 
These pages provide comprehensive functionality and can be accessed directly from the navigation menu 
provided at the top of each page, or via the alarm icons at the bottom left of each page. However to make these 
pages useful, we must first define some alarms and trends in the project. 

 
 
 
 
 
 
 
 
 

Configuring Alarms 
Switch to Citect Project Editor (click on the  icon or use Alt+Tab keys). In the Project Editor Menu click on 
Alarms, then click on Digital Alarms. 
 

 
 
Fill in the Digital Alarms form for a single alarm as shown below. Remember it is better to use the drop downs to 
ensure data is entered correctly. When the form is complete click Add. 
 
Remember that pressing Enter will add another record to your alarm list, so make sure the form is complete first, 
or use the Add button. 

 
 
 
 
 
 

Configuring Alarms continued… 
 

 
Unlike other SCADA 
packages, Citect’s Digital 
Alarms support a 
combination of two variable 
tags for alarming purposes. 
This makes it easy to mask 
alarms via a second PLC flag 
(eg. area in maintenance 
mode), without writing 
additional PLC logic.  
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Click on the  icon to close the Digital Alarms form when you are finished. 
 
 
 
 
Configuring Trends 
 

Now we need to configure a trend tag to store trend data. Switch to Citect Project Editor (click on  icon or 
use Alt+Tab keys). On the Project Editor Menu, click on Tags then click on Trend Tags. 
 

 
 
Fill in the Trend tag form as below then click Add. Remember to use drop downs where possible. 
 

 
Configuring Trends continued… 

 
 

Privilege levels are unique by 
default, not hierarchical. This 
means that a user with 
privilege level 6 does not 
automatically get access to 
level 5 functions. 
 
If you want your users to 
have access to more than 
one privilege level, then you 
should include all of those 
levels in the privilege field as 
shown in the configuration 
examples. 
 
To change the behavior of 
the system to hierarchical 
privileges, refer to the online 
help.

 
TIP 
In the Variable Tag fields, 
you can place an expression 
(eg. Pump_1_Mode = 0) to 
reverse the alarm detection 
logic.  
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This configuration will log the Pump_1_Speed to disk every ½ second. Most installations would typically log the 
majority of their data at 2 seconds or slower except for their key operating parameters. 
 
There are many more trend features available in Citect. Press F2 with this form open to see some of the 
advanced possibilities. Pressing F2 again will return you to the basic menus. 
 
Click on the  icon to close the Trend Tags dialog. 
 
 
 
 
Configuring Security 
 
Most projects require secure user authentication before they will allow control activities to be executed from the 
HMI. In Citect this can be achieved via local users, or Windows users. 
 
In addition to any security that we might configure on our own objects, we also need to define security login 
credentials to access all of the functionality available from the built-in pages supplied with Citect. Switch to the 
Citect Project Editor. 
 
On the Project Editor Menu, click on System then click on Users. 
 

 
 
 
Fill in the User form as below then click Add. 

 
 
 
 
 
 
 
 
 
 
 
 

Configuring Security continued… 
 
 

 

Local users are managed 
from within the Citect 
configuration environment. 
 
Windows users (refer Roles 
below) are managed from 
either the Windows operating 
system, or a networked 
domain server. 
 
 
TIP 
There are additional options 
for security allocations. Press 
F2 to view the additional 
parameters available for 
Users and Roles. 
 
Global privileges assign 
access rights across all areas 
of the project. 
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The password fields contain “*” to hide passwords from prying eyes. Do not type *, instead type citect into this 
field. The asterixes or hidden characters will appear as you type. 
 
This user has been configured for maximum security privileges throughout the project and will be able to access 
the advanced tools available from the navigation bar. 
 
We will also add a Windows Administrator group, and a Windows Restricted user with fewer privileges. 
 
On the Project Editor Menu, click on System then click on Roles. 
 

 
 
 
Configure the Windows Administrator group to have full access across all areas of the project, similar to the 
kernel user we have just added. 
 

 
 
 
 
 
 
 
 

Configuring Security continued… 
 
 

You can replace individual 
instances of found items by 
clicking on them and 
selecting Replace. 
 
TIP 
If a graphics page is open 
when changes are made to it 
using the replace feature, you 
will need to manually save 
the page to persist the 
changes. 
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Add the Windows Users group to have access to privilege level 1 across all areas of the project. 
 

 
 
 
Click the close  button when you have finished. 
 
 
 
 
Using Find and Replace 
 
We are going to perform rework on the variable tag Pump_1_CMD. We are going to change its name to 
Pump_1_RUN to better represent its function. Rather than searching the entire project for each place this tag is 
used, we are going to use the project search and replace feature to perform this exchange for us.  

  
Switch to the Citect Project 
Editor. In the Project Editor 
Menu, click on Edit then click 
on Replace (or use Ctrl-R). 
 
 
 
 
 
 
 
 
 
 
 

Using Find and Replace continued… 
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Type Pump_1_CMD in the Find box, and Pump_1_RUN in the Replace with box. Make sure Current Project is 
selected, along with all search options checked. 
 
Click Find. 
 

 
 
The utility will display a list of all locations where the Pump_1_CMD tag is found. 
 
Click Replace all. 
 
Confirm the replace when prompted, and (if you still have the page open), switch to the graphics builder to save 
changes to your page. 
 
Congratulations. You have completed the offline configuration portion of this tutorial. The following sections show 
you how to configure the online portions of the project. 
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Runtime 
 
Now it’s time to run your project and test it to make sure that you have completed the tutorial correctly. 
 

Compile your project, then Click on the Runtime  icon. 
 
Use the navigation menu to access your graphics display called MyPage. 
 
Click on Auto button then click On Manual. Click On/Off. 
 
You will see that both pipes change color as the group properties you configured will be applied to everything in 
the group, in this case both pipes. 
 

 
 
 
 
You will also see an alarm is generated and displayed on the alarm bar at the bottom of the page when you 
switch to Manual mode. The Alarm icon at the bottom left will flash to indicate that you have new, 
unacknowledged alarms. Click on this Alarm icon to view the Alarm page. 

 
 

Use the back  button 
at runtime to go back through 
the pages that you have 
visited. 
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Runtime continued… 
 
 

 

 
 
If you try to acknowledge the alarm from the alarm menu at the top left of the screen, or by right-clicking on an 
alarm, you will notice that you do not have access to these features. By default you require a privilege level of 1 
to use these features. 
 
Click on the Logon button or pull-down menu on the navigation bar. This will produce a Login form in which you 
can enter your user name and password as shown below. Use the local Citect user we created called kernel, 
with a password of citect. Alternatively, if you know your local computer admin account, or domain admin 
account, you can login using those credentials as shown in the second example below. 
 
 

  OR    
 

If your login was successful, you should see the logged in user name at the top right of the page. The alarm 
acknowledge functions will now be available to you. 

 

Windows users local to the 
Citect PC can use the login 
name directly, but domain 
users will require the domain 
name, followed by a back-
slash, then the user name. 
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Runtime continued… 
 
 

 

 
 
 
Once logged in, try accessing the alarm acknowledgement features again. This time they will work. 
 
You will notice that the alarm changes color once acknowledged, and disappears when you return the pump to 
automatic. If the pump returns to automatic and you have not acknowledged the alarm, it will remain on the 
screen until you do acknowledge it. This ensures that the operator never misses an alarm incident. 
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Runtime, Trends 
 
 

 
From the navigation menu, select Configure Trend Groups from the 
Trends navigation menu. 
 
 
 
 
 
 

 
Type in a name for your first trend group, nominally Pump_1. Then use the build buttons to add Pump_1_Speed 
to the group. 
 

 
 
When you are finished, click Add, then close the window by clicking on the  icon 
 
Now select Single Trend from the Trends navigation menu. 
 

Use the Trend Groups button  to select a trend group for display. By manipulating the pump speed via the 
slider on MyPage, you should now see the trend value changing on the graph. 
 
There are many powerful features available on this page, including: 

■ Trend cursor Click and slide along the graph to locate the cursor which displays tool-tips to 

describe  

each pen at that location 

■ History mode Allows you to quickly and easily access historical data 

■ Zoom in/out Allows you to quickly and easily zoom the trend graph by highlighting an area and  

pressing the zoom button 

■ Scaling Allows you to change the minimum and maximum ranges for each pen 

■ Export Allows you to export raw time-stamped data to the clipboard or a file 

 
 
 
 
 

 
Trend Groups configuration 
can also be accessed from the 
Admin Tools option under the 
Tools menu. 
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Runtime, Trends continued… 
 
 
 
 

Take some time to get used to these features as they are key components to assisting you in analyzing and 
interpreting your production information. 
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Runtime, Process Analyst 
 
 

CitectSCADA has facility for viewing trends and alarms. The Process Analyst is an ActiveX object that can be 
embedded on your own page, or you can use the default page provided. 
 

Click on the Process Analyst  button to display this page. Initially this is an empty container ready to be 
configured. 
 

Click on the Add Pens  button. 
 

 
 
Click on Search to find all configured trend pens. Select the Pump_1_Speed pen and click Add.  

 
Now change the Type from Trends to Alarms. Repeat your search and select 
Pump_1_Mode from the alarm list. Click Add then, when you are finished, click 
OK. 
 
 
 

A new display pane will be added to the page displaying both the Pump_1_Speed analogue pen as well as the 
Pump_1_Mode digital alarm pen. If the gridlines do not appear, click on the graph area and it will refresh the 
display. 
 
Experiment with some of the control buttons (described on the next page), or click-and-drag on the graph itself to 
move through history. 

 

The Process Analyst can 
have many display panes. 
Each pane supports both 
digital and analogue pens. 
 
To create multiple panes, you 
will need to customize the 
toolbar so that the Add 
Panes button is available to 
you (see the Online Help). 
Alternatively, you can create 
a new pane each time you 
are selecting new pens for 
display. 
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Runtime, Process Analyst continued… 
 

 
 
Display/remove pen cursor. Once displayed, click and drag the cursor to reposition it on the graph. 

 

Display/remove pen cursor labels. Once displayed, click and drag them to reposition them on the 

graph. 

 

Toggle the object pane at the bottom of the page which lists display pens. This creates more room for 

the graph pane. 

 

Toggle Auto-Scroll. 

 

Zoom in 50% 

 

Zoom out 

 

Zoom using a click-and-drag zoom box 

 
 
 

 

 
 
 
We will now modify the appearance of the Process Analyst display. Click on the Properties  button. 
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Runtime, Process Analyst continued… 
 
 

 

 
 
Expand the tree to Pane 1 and modify the background color. You can select from the color palette, or create new 
palette items by entering the Red, Green and Blue values directly.  
 
In this case, enter 250, 250, 190, for Red, Green and Blue respectively, then click Add to Custom Colors. 
 
Select this new color and click OK to record the change.  
 
Click Apply to see the effect on your Process Analyst view. 
 
Now select Pump 1 Speed in RPM beneath Pane 1 in the properties tree.  
 

 
 
Change the line color to bright red and the width to 2, and the interpolation from Straight to Stepped.  
 
Click OK to see the effect on your Process Analyst view and close the properties window. 

 
 
 
 
 
 
 
 

 
 
Interpolation is the manner in 
which the display shows links 
between sample points. 
Straight means that it draws 
a line directly between two 
points. Stepped means it 
holds the last sample value 
until it reaches the time of the 
new sample, and then ‘steps’ 
to the new value. 
 
Stepped interpolation is a 
more accurate indication of 
the samples that Citect 
SCADA has recorded. 
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Runtime, Process Analyst continued… 
 

 
Finally, resize the Object pane to maximize the graph pane while still showing the list of pens. 
 

 
 
Your Process Analyst view is now complete, but before you leave the page, click on the Save  button. This 
will allow you to save the Process Analyst configuration you have just entered, and retrieve it again later on. 
 

Fill in the file name and click Save. This will allow 
you to return to this view quickly at a later time 
using the Load View  button. 
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Administrative Tools 
 
CitectSCADA comes with a number of commonly used administrative and debugging tools built into its default 
menu. 
 

Select Admin Tools from under the Tools menu. If you are not 
logged in, the menu options will be greyed out and inaccessible. 
 
 
 
 
 
 

 
If required, login as the Administrator as shown previously using either the kernel user, or a Windows 
Administrator user. 
 
Once logged in with the appropriate privilege level, the Admin Tool menu will change color to blue and become 
accessible. As well as access to common applications and file management tools, this page also allows access 
to System Setup (The Computer Setup Wizard), runtime and communications statistics, and online menu 
configuration. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Understanding the 
CitectSCADA Kernel and 
other advanced debugging 
utilities are covered in the 
CitectSCADA training 
courses. 
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Administrative Tools, Configuring the Menu 
 
 

 
In the Citect Configuration box, select Configure Menu. 

 
 
 
 
 
 
 
 
 

 
 
Expand the menu system by clicking on each + item. Each menu Button is a separate pull-down menu on the 
navigation bar. By right-clicking on each item, you can modify the items in its pull-down menu. 
 

 
Right-click on Pages under the Generic node. 
 
Select Delete Button from the available options. This will remove the 
entire Pages pull-down menu. We will now create our own Pages menu. 
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Administrative Tools, Configuring the Menu continued… 
 
 
 

Right-click anywhere in the left-hand pane and select New Button from the 
available options. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
Right-click on this new Button and select New Item from the available 
options. 
 
 
 
 
 
 
 
 
 

 
 
Right-click on this new Item and select Edit Item from the available 
options. Type MyPage as the Action, and select True from the pull-
down list for the Checked option. 
Click OK. 
 
 
 
 

Menu Configuration allows 
the following types of items to 
be added to the menu: 
 
New Page 
Items under new Pages will 
only be available when the 
user is looking at a page of 
the same name. This allows 
menu items to be hidden 
unless on a particular page. 
 
New Button 
Adds another button to the 
navigation bar allowing 
additional pull-down menus 
to be created. 
 
New Item 
Adds an item into the pull-
down menu of a Button. 
 
New Sub-Item 
Extends pull-down menus to 
have child-menus which will 
appear when selected from 
the parent menu. 

Actions must refer either to the name of a page to display or 
a Cicode function.  
 
If specifying a Cicode function, it must be prefixed by a 
question mark ("?"). 
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Administrative Tools, Configuring the Menu continued… 
 

 
This pull-down item is now configured to display MyPage when it is selected from the navigation bar. 

 
Single-click on the New Item, and change its name to My Page. 
 
 
 
 
 
 
 
Single-click on the New Button, and change its name to My Menu. 
 
 
 

Click on the  icon to close the Menu Configuration dialog. When prompted, make sure you save the 
changes you have made. 
 
These changes will take effect when you next change pages. Select a new page from the navigation bar, and 
verify that your new menu appears with the new page as shown below. 
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Administrative Tools, Tag Debug 
 
 

Finally we will look at an extremely useful testing and commissioning tool – the Tag Debugger. 
 
 

Return to the Administration Tools page, and select Tag Debug from the Tools menu. 
 
 
 
 
 
 
 
 
 
In the dialog provided, type in Pump_1_Mode (alternatively use the Browse feature to navigate and select the 
same tag), and then click Read. 
 

 
 
If the pump is currently in Manual, the Tag Value should return a “1”. If it is Automatic it should return a “0”. 
Verify that the correct value was returned by checking the state of the lights on MyPage. 
 
Change the value to the opposite state by typing a 1 or 0 into the Tag Value to replace the value that was read. 
Click Write. 
 
Verify that the new value was written to the tag both by clicking Read again, and by checking the state of the 
lights on MyPage. 
 
 
WARNING 
Tag Debug is a powerful utility that can access any tag in the CitectSCADA system and both verify its state/value 
as well as change it. As such, it should be used with caution, especially when changing values for tags which 
control equipment! 



 

 
Page 75 of 80 

Quickstart Tutorial V7.10
 

75  

Backing Up Your Project 
 
 

It is important to keep backup copies of your project, so that you can always recover from a disaster with 
minimum effort.  
 

Make sure you are in the Citect Explorer (click on the  icon or use Alt+Tab), and have the Tutorial project 
selected. 
 

Click on the Backup icon .  
 

 
 
Use the Browse button to locate a directory where you want to save your files to. 
Alternately you can type the directory and filename into the Backup File edit box. If the directory does not exist 
CitectSCADA will automatically create it for you when it saves the file. 
 
Click OK and when the Backup Complete message pops up, click OK on that also. 
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Restoring Your Project 
 

With any software, it is good practice to check and make sure you can restore from your backup copies. It is very 
rare to experience problems restoring from a CitectSCADA backup but the time taken to check is a tiny fraction 
compared to the time it would take to recreate the project from scratch.   
 

Click on the Restore icon  (it is next to the backup icon), on the menu bar click Tools then Restore. 
 

 
 
Click on the Browse button to locate your backup file. 
 
We will restore to a new project, test it, and then delete it, as this is a much better test than restoring over the 
existing project and less chance of anything going wrong (eg; what if the power fails half way through restoring 
over the top of your existing project or your backup has a fault in it?). 
 
Make sure New Project is checked. In the Name edit box type a name for the new project e.g; TutorialTest then 
click OK.   
 
When the restore is completed (click OK on the Restore Complete Dialog), click on the TutorialTest project to 
switch to that project, then change to the Citect Project Editor to compile the project before clicking on the 
Computer Setup Wizard and repeating the Setup steps identified earlier in this tutorial to configure the computer 
to run the Tutorial Test project in stand-alone mode. 
 
Make sure you have shutdown the Tutorial project prior to attempting to run the TutorialTest project.  
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Restoring Your Project continued… 
 
 
 

 
 
Click on the Citect Runtime icon  to make run your project and prove your backup and restore operation 
was successful. 
 
To delete the TutorialTest project, click File on the Citect Explorer menu, then click Delete Project. 
 
 
Congratulations! By now you should have a basic working knowledge of CitectHMI/SCADA software. If you are 
keen to build your level of competency we recommend that you attend a Citect Training Course. Details of 
training courses can be found at www.citect.com or by contacting your local Citect office or distributor.  

 
 
 
 



 

 
Page 78 of 80 

Quickstart Tutorial V7.10
 

78  

Troubleshooting 
 
If you experience results that are different to what you see in the tutorial… 
 

1. Go back and double check what you have done.  Most likely you have done something different 

from  

             the instructions. 

2. The tutorial largely assumes CitectHMI/SCADA is freshly installed and default settings haven’t been 

             changed. By taking a closer look at the screens in the tutorial you may be able to identify any  

             differences. 

3. If problem is in Runtime, shutdown runtime and restart it. 

4. Read the Online Help. Most dialog boxes have a help button that provides context sensitive  

            information with just a mouse click. 

5. Read the CitectHMI/SCADA knowledgebase. This is available on the CitectHMI/SCADA software 

CD  

            or from our website www.citect.com. 

6. Worst case, start again, just create a new project and call it Tutorial2. The upside to this is the extra  

            practice will make you more proficient. 

 
If nothing appears to happen when you press a button, do not press it repeatedly in the hope that something will 
happen – chances are your PC is busy trying to do what you’ve already asked it to do.  
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Addendum – Security Validation 
 
CitectSCADA V7.10 contains additional security functions to make it easier for companies to implement 
electronic signatures and multi-user validation. This last exercise will modify the Pump 1 manual button to 
require signature validation before setting the Pump_1_Mode value to 1. 
 

Switch to the Graphics Builder – click on the Graphics Builder icon .  
 
Open your MyPage graphics display, and double-click on the Manual button to access it’s animation properties. 
Click on the Input tab, and modify the command to: 
 
MultiSignatureTagWrite("Pump_1_Mode", "1", "", "kernel", "", "", "") 
 

 
 
Save your page. 
Switch to the Citect Editor and compile your project. 
Run your project. 
 
Once the project is running, open MyPage, and click on the Manual button. Instead of immediately changing the 
pump’s mode to manual, Citect will display an electronic signature verification form. 

 
Click on the Verify button. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Addendum – Security Validation continued… 
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A new verification form is displayed, prompting for the kernel user’s password. This will display even if the kernel 
user is already logged in. 
 

Type in the kernel user’s password citect, then 
Click OK. 
 
 
 
 
 
 
 
 
 
 

 
A final verification form is displayed, allowing the user to verify that the action should be performed. 
 
 
 

Click Approve. The pump mode will now be 
changed to Manual. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Further information on electronic signatures and user validation can be found in the online help. 


